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1.Configure the Arduino

1.1 What is Arduino?

Arduino is an open-source electronics platform based on easy-to-use hardware and software.
Arduino boards are able to read inputs - light on a sensor, a finger on a button, or a Twitter message
- and turn it into an output - activating a motor, turning on an LED, publishing something online. You
can tell your board what to do by writing the program code in the IDE and sending the instructions
to themicrocontroller on the board. To do so you use the Arduino programming language (based on
Wiring), and the Arduino Software (IDE), based on Processing.

1.2 Install the Arduino IDE for Windows

1. Visit https://www.arduino.cc/en/software to download the latest Arduino IDE version for your
computer’s operating system. There are versions forWindows,Mac, and Linux systems.

The Arduino IDE 2
The Arduino IDE 2 is a big step from its sturdy predecessor, Arduino IDE 1.x, and comes with
revampedUI, improved board& librarymanager, debugger, autocomplete feature andmuchmore.
Herewewill showhow to download and install the Arduino IDE 2.21 on yourWindows
You can choose between the Installer (.exe) and the Zip packages. We suggest you use the first one
that installs directly everything you need to use the Arduino Software (IDE), including the drivers.
With the Zip package you need to install the drivers manually. The Zip file is also useful if you want
to create a portable installation.

1.Herewe click on the “WindowsWin 10 and newer, 64 bits” option for the easiest installation.

https://www.arduino.cc/en/software
https://arduino.cc/en/Guide/PortableIDE
https://downloads.arduino.cc/arduino-ide/arduino-ide_2.3.2_Windows_64bit.exe
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2. Save the .exe file
downloaded from
the software page to
your hard drive and
simply run the file .

3. Read the License
Agreement and
agree it.

4. Choose the
installation options.
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5. Choose the
install location.

6. Click finish and
run Arduino IDE
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1.3 Install Driver for KEYESTUDIO ESP32 PLUS Board

KEYESTUDIO ESP32 PLUS Board a universalWIFI plus Bluetooth development board based on ESP32,
integratedwith ESP32-WOROOM-32module and compatible with Arduino.
It has a hall sensor, high-speed SDIO/SPI, UART, I2S as well as I2C. Furthermore, equipped with
freeRTOS operating system,which is quite suitable for the Internet of things and smart home.

Specifications

Voltage: 3.3V-5V
Current Output: 1.2A(maximum)
Maximumpower Output: 10W
Working temperature: -10℃~50℃
Dimension: 69*54*14.5mm
Weight: 25.5g
Environmental protection attributes: ROHS
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Install driver

Connect the ESP32 board to the computer andwait forWindows to begin its driver installation
process. Often CH340 driverwill be automatically installed by your systemwhenusing Arduino. You
can check the DeviceManager or the port of the Arduino IDE to see if the driver is successfully
installed.

If the CH340 driver is not installed automatically, we need to install it manually. We have provided
the CH340 driver in the tutorial package for you to use.

1.Open theDeviceManager by right clicking “MyPC” and selecting Properties.
Look underOther devices. You should see an open port namedUSB Serial

2.Right click on the "USB Serial" and choose the "Update Driver" option.
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3.Choose the "Browsemy computer for Driver software" option.

4. Select the driver file named "CH340 Driver File-Windows", located in the Driver Folder of the
tutorial package.

5.Driver successfully installed.
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5. Device Manager will automatically refresh. Look under Ports (COM & LPT). You should see an
open port named “USB-SERIAL CH340(COM8)”

6.Click Tools>Port at Arduino IDE, you can find the same COMport as the CH340 driver in the device
manager.
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1.4 Introduce of Arduino IDE 2.0

Verify / Upload - compile and upload your code to your Arduino Board.

Select Board & Port - detected Arduino boards automatically show up here, along with the port

number.

Sketchbook - here you will find all of your sketches locally stored on your computer. Additionally,

you can sync with the Arduino Cloud, and also obtain your sketches from the online environment.

Boards Manager - browse through Arduino & third party packages that can be installed. For

example, using aMKRWiFi 1010 board requires the Arduino SAMDBoards package installed.

Library Manager - browse through thousands of Arduino libraries, made by Arduino & its

community.

Debugger - test and debug programs in real time.

Search - search for keywords in your code.

Open SerialMonitor - opens the SerialMonitor tool, as a new tab in the console.

If you want to learn more about Arduino IDE, please refer to this document：Getting Started with

Arduino IDE 2

https://docs.arduino.cc/software/ide-v2/tutorials/getting-started-ide-v2
https://docs.arduino.cc/software/ide-v2/tutorials/getting-started-ide-v2
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1.5 Add Libraries to Arduino IDE

WhyUse Libraries?
Libraries are incredibly useful when creating a project of any type. They make our development
experience much smoother, and there almost an infinite amount out there. They are used to
interface with many different sensors, RTCs, Wi-Fi modules, RGB matrices and of course with other
components on your board.

Including a Library in the sketch

To use a library, you
first need to include
the library at the top of
the sketch.
If you find a line of
code in the format of
#include <library
name> at the
beginning of the code
when using our code, it
means that you need
to add this library file
to arduino IDE first
before you can
successfully upload this
code.

To make the smart
farm kit work, we will
need to add these
library files to the
Arduino IDE.
You can find them in
the tutorial package.
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Importing a .zip Library

In the menu bar, go to
Sketch > Include
Library > Add .ZIP
Library...
You will be prompted
to select the library you
want to add.

Navigate to the .zip
file’s location and open
it.

You may need to
restart the Arduino IDE
for the library to be
available.
After successfully
installing the library
file, you will see them
in the list.
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1.6 Configure the development environment for ESP32

Before using Arduino IDE to program the smart farm, you need to configure the Arduino IDE,

select the correct board type (ESP32 Dev Module) for the ESP32 Plus board, and select the

COM port that is assigned in the device manager.

There is no option for ESP32 in
Arduino's default board list, sowe
need to install itmanually.

Click File > Preferences.
Copy the link of ESP32 board
(https://espressif.github.io/arduin
o-esp32/package_esp32_index.js
on) into theAdditional boards
manager URLs, and clickOK.

https://espressif.github.io/arduino-esp32/package_esp32_index.json
https://espressif.github.io/arduino-esp32/package_esp32_index.json
https://espressif.github.io/arduino-esp32/package_esp32_index.json
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Click the icon of "Board
Manager" in the upper left
corner.

Enter "esp32" in the search box.
Install the ESP32 environment in
Arduino :2.0.6 (ESP32 by
Espressif Systems).

Note: Youmust select
version2.0.6, otherwise itmay
be incompatible with the library
fileswe provide.

Click Tools> Board > esp32 ,and
choose the EPS32DevModule.

Click Tools > Port, then select port
"COM-XX"which is shown in
DeviceManager.
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2.Set the Angle of the Servo.

In the next lesson, wewill assemble this smart farm kit. Before assembling the servo to the kit, we

need to set its angle to 180° so that it will work as expected.

You need to prepare:

Wiring

1.Connect the servo to the pin io26 of
the Esp32 plus board
Note: The brown, red and orange wire
of the servo are respectively attached
toGnd(G), 5v(V) and Pin io26.

2.Connect the Esp32 plus board to the
computer

Esp32 plus board*1

9G 180°Servo*1USB Cable*1Esp32 plus board*1
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3.Make sure you have installed
the ESP32_Servo.h library for
the Arduino IDE. If not, please
refer to the previous section to
install it.

4.Open thewindow_servo
code provided in our tutorial
packagewith Arduino IDE.

5.Click on Tools, select "EPS32
DevModule" for the board
type, and select COM-XX for
Port as shown in the Device
Manager.

6.Click on upload >>>done
uploading, the servowill be set
to 180°.

.
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3.Assemble the Smart Farm Kit

Step 1 Install the ESP32 Board and the Relay Module

1.1 Required components

1.2
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1. 3

1.4
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1.5

Step 2 Install the Fixing Frame for Battery Case and install the Feeding Cabin,

connect the ESP32 board and the Relay Module
2.1 Required components
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2.2 Assemble the Battery Case Holder

2.3
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2.4

2.5
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2.6

2.7
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2.8 Connect the ESP32 board and the Relay Module

Module Wire Pin of the esp32 board

Relay Module 3PIN 20cm IO25

Module Pin Wire Color ESP32 Board Pin

V RED V

G BLACK G

S YELLOW io25
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Step 3 Install the Substructure of the house

3.1 Required components

3.2
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3.3

3.4



27

3.5

3.6
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3.7

3.8
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3.9

3.10

Note the installation direction of the board, with M facing us.
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Step 4 Install the Door of the Feeding Cabin

4.1 Required components

4.2

The acrylic sheet is packed separately, and it is recommended that you tear off its protective

film to reduce the friction when it moves as a door.
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4.3

4.4 Note: The screws need to be tightened to keep the servo stable, otherwise the door may

get stuck
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4.5

4.6
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4.7

4.8 Do not turn the gear after it is installed on the servo. If you have already turned the gear

you will need to readjust the servo angle to 180°.
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4.9

Note:

Cover the hole below with the door. Keep the door closed in its initial state.

4.10
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4.11 Test the door！

1) Connect Servo to pin IO26 of the ESP32 board. Connect yellow to S, red to V, black to G.

2) Connect 6 AA batteries to the DC 7-12V port of ESP32 board. (Batteries not included in the

kit)
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3) Upload the Test code

NOTE: After uploading the code, if the door cannot be opened and closed and the servo is hot, please turn off the

power immediately.

And check:

1. Whether the plastic door has good contact and force points with the gear structure of the servo.

2. Whether the tip of the fixing screw on the gear structure of the servo is stuck with the plastic shell of the

servo. If so, please loosen the fixing screw a little to prevent its tip from contacting the servo.

1. Connect the ESP32 board to
the computer with the usb
cable. Open the INO file inside
the 6.1Servo folder with
Arduino IDE.

2. Click on Tools, select "ESP32
Dev Module" for the board
type in the drop-down menu
bar, and select COM-XX for
Port (According to the port
assigned by your computer in
the devicemanager)

3. Please make sure you have
uploaded the ESP32_Servo
library and then upload the
code. The door of the feeding
cabin will open and close
slowly.
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Step 5 Install the LCD display and the DHT11 Sensor

5.1 Required components
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5.3

5.4
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5.5

5.6 Connect modules via Dupont wires.

Module Wire

Temperature and Humidity Sensor 3PIN 20cm

Connect yellow wire to S, red wire to V, black wire to G.
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5.7

Module Wire

LCD 1602 4PIN (Black-Red-Blue-Green)

Connect green to SCL, blue to SDA, red to VCC, black to GND.

Step 6 Install the Ultrasonic Module

6.1 Required components
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6.2

6.3
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6.4 Wiring

Module Wire

Ultrasonic module 4PIN (Black-Green-Blue-Red)

Pay attention to the color of the Dupont wire: For the ultrasonic module, connect blue to TRIG,green to ECHO, red to VCC,
black to GND.

Step 7 Install the PIR Motion Sensor and Button Module
7.1 Required components
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7.2

7.3
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7.4 Wiring

Connect modules via Dupont wires.

Module Wire

PIR Motion Sensor 3PIN 15cm

Button Module 3PIN 15cm

Pay attention to the color of the Dupont wire: Connect yellow to S, red to V, black to G.
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Step 8 Install the Walls of the House
8.1 Required components

8.2
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8.3

8.4
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8.5

8.6
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8.7

8.8
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8.9 Wiring

Module Wire

Fan 4PIN (Black-Red-Blue-Green)

Steam Sensor 3PIN 15cm

Photoresistor 3PIN 15cm

Pay attention to the color of the Dupont wire: Connect yellow to S, red to V, black to G, blue to IN+, green to IN-.

Step 9 Install the Roof of the house
9.1 Required components
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9.2

9.3
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9.4 Keep the wires organized

Step 10 Install the House and Ground
9.1 Required components
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10.2

10.3
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10.4

10.5
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10.6 Arrange the wires

10.7
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Step 11Wiring the House
11.1 Wiring List

Pay attention to the color of the Dupont wire: Connect yellow to S, red to V, black to G.

NO. Components Wires ESP32 Board Pins

1 Fan 4pin, Divided Black-Red-Blue-Green io18(IN-) | io19(IN+)

2 PIR Motion Sensor 3pin 15cm io23

3 Button 3pin 15cm io5

4 Ultrasonic Module 4pin,Divided Black-Green-Blue-Red D12(TRIG) D13(ECHO)

5 LCD 1602 4pin, Connected I2C

6 Temperature and Humidity Sensor 3pin 20cm io17

7 Steam Sensor 3pin 15cm io35

8 Photoresistor 3pin 15cm io34

9 Servo -- io26

10 Buzzer 3pin 20cm io16

11 LED 3pin 20cm io27

12 Water Level Sensor 3pin 25cm io33

13 Soil Humidity Sensor 3pin 20cm io32

14 Water Pump 3pin 20cm io25

11.2 Fan

Pass the Dupont wire connected to the fan through the holemarked 30 on the wooden board.

Components Wire ESP32 Board Pins

Fan 4PIN Divided (Black-Red-Blue-Green) io18(IN-), io19(IN+)

Module Pin Wire Color ESP32 Board Pins

IN- GREEN io18(IN-)

IN+ BLUE io19(IN+)

V RED V (io19)

G BLACK G (io19)
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11.3 PIR Motion Sensor

Pass the Dupont wire connected to the PIR motion sensor through the holemarked 24 on the wooden board.

Component Wire ESP32 Board Pin

PIR Motion Sensor 3PIN 15cm io23

Connect red to V, black to G, yellow to S.

Module
Pin

Wire
Color

ESP32
Board Pin

V RED V

G BLACK G

S YELLOW io23

11.4 Button Module

Pass the Dupont wire connected to the button module through the holemarked 25 on the wooden board.

Component Wire ESP32 Board Pin

Button 3PIN 15cm io5

Connect red to V, black to G, yellow to S.

Module Pin Wire Color ESP32 Board Pin

V RED V

G BLACK G

S YELLOW io5
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11.5 Ultrasonic Module

Pass the Dupont wire connected to the ultrasonic module through the holemarked 25 on the wooden board.

Component Wire ESP32 Board Pins

Ultrasonic Module 4PIN Divided (Black-Green-Blue-Red) io13(ECHO), io12(TRIG)

Connect red to V, black to G, blue to io12, green to io13.

Module Pin Wire Color ESP32 Board Pins

V RED V (io12)

G BLACK G (io12)

ECHO GREEN io13

TRIG BLUE io12
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11.6 1602 LCD Display

Component Wire ESP32 Board Pins

LCD1602 4PIN Connected (Black-Red-Blue-Green) I2C

Connect red to V, black to G, blue to SDA, green to SCL.

Module Pin Wire Color ESP32 Board Pins

V RED V (I2C)

G BLACK GND (I2C)

SCL GREEN SCL (I2C)

SDA BLUE SDA (I2C)
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11.7 Temperature and Humidity Sensor

Pass the Dupont wire connected to the button module through the holemarked 20 on the wooden board.
Component Wire ESP32 Board Pins

Temperature and Humidity Sensor 3PIN 20cm io17

Connect red to V, black to G, yellow to io17.

Module
Pin

Wire
Color

ESP32
Board
Pin

V RED V

G BLACK G

S YELLOW io17
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11.8 Steam Sensor

Component Wire ESP32 Board Pin

Steam Sensor 3PIN 15cm io35

Connect red to V, black to G, yellow to io35.

Module Pin Wire Color ESP32 Board Pin

V RED V

G BLACK G

S YELLOW io35

11.9 Photoresistor

Component Wire ESP32 Board Pin

Photoresistor 3PIN 15cm io34

Connect red to V, black to G, yellow to io34.

Module Pin Wire Color ESP32 Board Pin

V RED V

G BLACK G

S YELLOW io34
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11.10 Servo

Pass the wire of Servo through the Hole 15, and then connect it to ESP32 board.

Component Wire ESP32 Board Pin

Servo 3PIN io26

Connect red to V, black to G, yellow to io26.

Servo Pin Wire Color ESP32 Board Pin

V RED V

G BLACK G

IO26 YELLOW io26
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11.11 Buzzer

Pass the wire of Buzzer through the Hole 17, and then connect it to ESP32 board.

Component Wire ESP32 Board Pin

Buzzer 3PIN 20cm

Connect red to V, black to G, yellow to io16.

Module Pin Wire Color ESP32 Board Pin

V RED V

G BLACK G

S YELLOW io16

11.12 LED Module

Pass the wire of LED through the Hole 7, and then connect it to ESP32 board.

Component Wire ESP32 Board Pin

LED 3PIN 20cm io27

Connect red to V, black to G, yellow to io27.

Module Pin Wire Color ESP32 Board Pin

V RED V

G BLACK G

S YELLOW io27
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11.13 Water Lever Sensor

Pass the wire of water level sensor through the Hole 13, and then connect it to ESP32 board.

Component Wire ESP32 Board Pin

Water Lever Sensor 3PIN 25cm io33

Connect red to V, black to G, yellow to io33.

Module Pin Wire Color ESP32 Board Pin

V RED V

G BLACK G

S YELLOW io33
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11.14 Soil Humidity Sensor

Pass the wire of soil humidity sensor through the Hole 11, and then connect it to ESP32 board.

Component Wire ESP32 Board Pin

Soil Humidity Sensor 3PIN 20cm io32

Connect red to V, black to G, yellow to io32.

Module Pin Wire Color ESP32 Board Pin

V RED V

G BLACK G

S YELLOW io32

11.14 Relay Module and Water Pump

Pass the wire of Water Pump through the Hole 40 in the way as shown below:
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The red wire of the water pump is connected to the middle terminal of the relay module, and the black wire
is connected to the GND of the ESP32 board.
In addition, you need to use a Dupont wire to connect the left terminal of the relay module to the 3.3V of
the ESP32.

Insert the male terminal of the Dupont wire into

the female terminal of the relay module and

tighten it with a screwdriver.
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Step 12 Install the house and foundation
12.1 Required component

12.2
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12.3

12.4
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Step 13 Install the Plastic Sinks

13.1
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Step 14 Install the soil module and water level module
14.1 Required components
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14.2

14.3
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14.4

14.5
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14.6

14.7
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Step 15 Install fence
15.1

15.2
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15.3

15.4 This wooden board is used to fix the water pump.
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Step 16 Install the Buzzer and the Led Module
16.1 Required components

16.2
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16.3

16.4
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Step 17 Decorate the House
17.1 Required components

17.2
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Step 18 Install Solar Panel
18.1

18.2
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18.3

18.4
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18.5 Install the LED light of the solar panel into this hole.

18.6 Use a sticker to secure its wires to the wall
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18.7

18.8
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Step 19 Install Battery Case

19.1

19.2 Install 6 AA batteries（Not included in the kit）



83

19.3

19.4
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4.Projects

Things to note before starting the projects

Pleasemake sure you have configured the Arduino according to section 1.

1. Driver for KEYESTUDIO ESP32 PLUS Board

2. Add Libraries to Arduino IDE

3. Install ESP32 environment in Arduino :2.0.6 (ESP32 by Espressif Systems).

Note: You must select version 2.0.6, otherwise it may be incompatible with the library files we
provide.
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Click on Tools, select "EPS32 Dev Module" for the board type, and select COM-XX Port that the
computer assigns to your Arduino device.

4. You can download all the files needed to run the robot arm, including the driver, codes, libraries,
etc:
https://fs.keyestudio.com/KS0567

5. You need to prepare a 2.4 GHzWiFi(It can be a mobile hotspot or a router), another phone that
can connect to the sameWiFi and install the appwe provided.

Arduino'smemory can store a project at a time, updating the code erases the previous code.
Let's learn how this smart farmworks step by step through projects of different difficulty levels.

https://fs.keyestudio.com/KS0567
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4.1 Lighting System

1.1 Light up an LED

Open the 1.1Blink codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:
LED blinks per second, because io27 on ESP32 board outputs high and low level alternatively every
second.

Power Level Result

HIGH LED on

LOW LED off
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1.2 Control the LEDwith PWM

Open the 1.2PWM codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:

At an appropriate signal frequency, PWM changes effective output voltage by changing the duty
cycle in one period. In plain English, within a specified time, themore high level the IO port outputs,
the greater PWMvalue is, and the lighter LEDwill be.

The LEDmodule will slowly light up fromdark to bright, and then fromdark to bright.
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1.3 Read the digital value of Button

Open the 1.3Button codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:
Open serialmonitor and set the baud rate to 9600.
When the button is released, the value is 1; if you press the button, it becomes 0.

The principle of the buttonmodule is a circuit controlled by this button.
When the button is pressed, the circuit is closed so that current passes through the button to GND,
which causes the digital input pin to detect a low level.
When the button is released, the circuit is cut and pin level increases due to a pull-up resistor, which
makes the digital pin to detect a high level.
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1.4 Auto-locking Button

Open the 1.4Self-Locking_Button codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:
Open serialmonitor and set the baud rate to 9600.
When you press the button once, 1 will be displayed. If you press button for the second time, the
value becomes 0. Now, a common button boasts the function of an auto-locking one.



90

1.5 Use the button to control LEDmodule

Open the 1.5Lighting-System codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:
When you press the button once, LED lights up; if you press again, LED turns off. This operation is a
loop,which is consistent with the lighting principle in reality.
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4.2 Light Control System

2.1 Photocell-sensor

Open the 2.1Photocell-sensor codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:
Open the serial monitor.
The brighter the light detected by the photoresistor is, the greater the value will be.

A photoresistor module converts light signal into electric signal (voltage, current, and resistor).
When light hits the photoresistor, the stronger the light is, the smaller the resistance will be, so the
greater the VCC voltagewill pass through the photoresistor.
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2.2 Light Control System

Open the 2.2Light-Control-System codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:

When the value of the photoresistor is greater than 800 (in daytime), LED goes off. However, if the
value is less than 800, LEDwill automatically light on.

\
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4.3 Alarm System

3.1 PIR Motion Sensor

Open the 3.1PIR-Motion-Sensor codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:

When someone is in the area, Someone is displayed on the monitor, and the red LED on the
sensor goes off. However, if there is no one, No one will be printed and the LED on the sensor
will always be on.

Voltage: 3~5V
Current: 3.6mA
Power: 18mW
Angle of View: Y = 90°, X = 110° (Theoretical value)
Detection Distance: ≤5m
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 Passive Buzzer cannot vibrate to emit sound itself, unless putting a
square wave signal with a certain frequency. Moreover, the
emitting sound varies due to the different frequency of square
wave, so a passive buzzer can simulate tunes.

o An analog squire wave can be generated by changing the
power level at pins. For example, after the high level
lasting for 500ms, it shifts to a low level for another 500ms
then to a high level again...

oWe drive the buzzer via a squire wave within 200~5000Hz,
and we can compute the frequency(f): f=1/T, T is the
period (the total time of high and low level).

Parameters:

Voltage: 3~5V

Current: ≤5mA

Power: ≤25mW

3.2 Passive Buzzer

Open the 3.2Passive-Buzzer codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:
Passive Buzzer keeps emitting sound.
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3.3 Buzzer-Tone

Open the 3.3Buzzer-Tone codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:

Buzzer alarms via tone() function.

tone() generates PWM signal with a certain frequency to drive the buzzer to vibrate, and the
duration and tone is controlled by related parameters.

There are two ways to define the duration. One is to adjust the parameters of the tone() function to
set a duration, and the other is to adopt a noTone() function to directly stop the sound. If you do not
define a duration in tone(), the sound signal will always be generated unless a noTone() stops it.

In Arduino, one sound can only be produced at a time. If one pin of ESP32 is generating a sound
signal via tone(), it is not acceptable to emit sound by this function on another pin.
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3.4 Buzzer-Music

Open the 3.4Buzzer-Music codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:

The buzzer will playmusic.
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3.5 Alarm System

Open the 3.5Alarm-System codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:
When the sensor detects amotion, buzzer emits sound and LED blinks to remind of an invasion.
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4.4 Rain Detection System

4.1 Steam Sensor

Steam sensor detects the presence of water, so it is usually used in rain detection. If the rain
hits the conductive pads on the sensor, it will send a signal to the Arduino board.

\

Open the 3.5Alarm-System codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:
Touch the detection area with your finger. The larger the area you touched is, the larger the value
will be.
You can open the serial monitor to observe the currently detected value (range: 0~4095).

Parameters:

 Voltage: 3~5V
 Current: 1.5mA
 Power: 7.5mW
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4.2 Rainwater Detection System

Open the 4.2Rainwater-Detection-System codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:
The greater the detected value of the steam sensor is, the loader the sound emitted by the buzzer
will be.
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4.5 Solar Power System

Parameters

 Voltage: 5V
 Current: 80mA
 Power: 400mW
 Dimensions: 60*60mm

Codes are not required in this project. Importantly, we learn about the new environmental
energy --- solar power.

When good illumination is provided, LED will light up in yellow. The brighter the light is, the
brighter the LED will be.

The solar panel absorbs light and directly or indirectly converts solar radiation into electricity.
Compared with ordinary coal power generation, solar, wind and water power are more
energy-saving and environment-friendly.

FAQ

Q: Why does solar panel still work without sunlight?

A: It works with not only sunlight but also ambient light. The brighter the light is, the greater the voltage will be, and the
lighter the LED will be.

The Sun emits energy in waves
with a wide range of wavelengths,
from ultraviolet to visible and
infrared light.

Wavelength of Ultraviolet:
150~400nm;

Wavelength of Visible Light:
400~760nm;

Wavelength of Infrared Light:
760~4000nm;
The panel absorbs one of these
ranges of wavelength and
converts them into electricity.
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4.6 Smart Feeding System

6.1 Door of feeding cabin

Open the 6.1Servo codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:

The door of feeding cabin is slowly opened and then closed.

NOTE: SG90 servo can rotate 180°. As the feeding box is small, 100° of rotation is enough
to completely close the box.

80°: fully open
120°: half open
180°: close

ATTENTION
Do not put your fingers into the box to avoid nipping!
Do not block the door with something to avoid damaging servo!
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The door is controlled by a servo.

Internal Structure:

①Signal(S): It receives the control signal from microcontroller.

② Potentiometer: the feedback part of the Servo. It measures the position of output shaft.

③ Embedded board (Internal controller): the core of the Servo. It processes external control signal and the
feedback signal of position and drives the Servo.

④ DC motor: the execution part. It outputs speed, torque and position.

⑤ Gear system: It scales the outputs from motor to the final output Angle ccording to a certain transmission
ratio.

Drive the Servo:

Signal(S) receives PWM to control the output of Servo, and the position of output shaft directly relies on the
duty cycle of PWM.

For instance:

 If we send a signal with pulse width of 1.5ms to Servo, its shaft(horn) will revolves to the
middle position(90°);

 If pulse width = 0.5ms, the shaft turns to its minimum(0°);
 If pulse width = 2.5ms, the shaft turns to its maximum(180°).

NOTE: The maximum angle varies from the types of Servos. Some are 170° while some are only 90°. In spite
of this, Servos usually will move a half (of the maximum) if they receive a signal with pulse width of 1.5ms.
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6.2 Ultrasonic-Sensor
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Open the 6.2Ultrasonic-Sensor codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:

In this kit, the detection range is within 3~8cm.

Open the serial monitor and set the baud rate to 9600, the serial monitor will display the
distance between the ultrasonic module and the obstacle in front.
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ATTENTION

Do not put your fingers into the box to avoid
nipping!

Do not block the door with something to avoid
damaging servo!

6.3 Intelligent Feeding System

Open the 6.3Intelligent-Feeding-System codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:

The smart feeding system intelligently feeds domestic fowls via an ultrasonic module and a
servo. The former detects the distance to animals while the later controls to open or close the
feeding box. When a pet is detected close to the box, servo opens it to feed.
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4.7 Temperature Control System

7.1 DHT11 temperature and humidity sensor

DHT11 temperature and humidity sensor outputs digital signals. It applies principles of analog
signal acquisition and conversion as well as temperature and humidity sensing technology, so
that it features long-term stability and high reliability. Besides, the sensor integrates a
high-precision resistive humidity sensor and a resistive thermosensitive temperature sensor,
and is connected with an 8-bit high-performance MCU.

Open the 6.3Intelligent-Feeding-System codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:
Open the serial monitor and set the baud rate to 9600, the serial monitor will display the the
current temperature and humidity value.



107

7.2 LCD 1602 Module

LCD 1602 possesses a standard 14-pin (without backlight) or 16-pin (with backlight) interface,
saving the pins of MCU. Its display drives IC to realize I2C control.

Open the 7.2LCD1602 codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:

LCD1602 opens its backlight and displays ”HELLO WORLD 0“ and ”HELLO WORLD 1“.
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7.3 Motor and Fan

130 Motor is able to adjust speed via PWM. In the process, two pins are needed to be
connected for controlling.

Open the 7.3Motor codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:

130motor alternatively rotates left and right every 2 seconds.

NOTE: Since the fan is a high-power electronic device, please remember to use batteries to power
it.
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7.4 Temperature Control System

Open the 7.4Temperature-Control-System codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:

When the temperature reaches 29°C, the fan will turn on to dissipate heat. When it is lower than
29°C, the fan will turn off (the fan just simulates heat dissipation, so the effect is not good), which
saves energy for the farm.
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4.8 Soil Humidity Monitoring System

8.1 Soil Humidity Sensor

Open the 8.1Soil-Humidity-Sensor codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:

Open the serial monitor. Touch the detection area of the sensor with a wet finger and the currently
detected humidity value will be printed on themonitor (range: 0~4095).

Soil humidity sensors are mainly used
to measure water content in
volumetric soil, monitor soil moisture,
irrigate crops and protect forests.

Pay attention!
Do not overflow water from plastic pools in experiments. Spilling water on other sensors may
cause not only a short circuit or modules to be out of work but also heat generation and even
explosion. Do be extra careful! Especially for younger users, please operate with your parents.



111

8.2 Soil Humidity Monitoring System

We adopt LCD1602 to reveal the real-time value of soil humidity value. When the value is lower
than the setminimumhumidity, the buzzer will emit sound to prompt farmers of irrigation.

Open the 8.2Soil-Humidity-Testing-System codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:

The LCD1602 displays the reveal the real-time value of soil humidity value.When the value detected
by the soil humidity sensor is lower than 200, the buzzer emits sound to alarm.

Pay attention!
Do not overflow water from plastic
pools in experiments. Spilling water on
other sensors may cause not only a
short circuit or modules to be out of
work but also heat generation and
even explosion. Do be extra careful!
Especially for younger users, please
operatewith your parents.
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4.9 Water Level Monitoring System

9.1 Water Level Sensor

The water level sensor integrates a series of exposed parallel lines to measure the volume of water
and droplets.

Open the 9.1Water-Level-Sensor codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:

Open the serial monitor. Touch the detection area of the sensor with a wet finger and the currently
detected valuewill be printed on themonitor (range: 0~4095).

Pay attention!
With the exception of the
detection area, the sensor is not
waterproof. Spilling water on
other area may result in a short
circuit.
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9.2 Water Level Monitoring System

Open the 9.2Water-Level-Testing-System codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:

LCD displays the real-time value of water level. When the water level sensor detects that the water
level is lower than 200, the buzzer starts to alarm.



114

4.10 Auto-Irrigation System

10.1 Water Pumping System

In this experiment, we use ESP32 development board to turn on/off the water pump by a relay
module. A pump lifts water and transports liquids, and usually is combined with a relay module in
usage.

RelayModule:

In usage, it is often used in the management of high voltage and load current, say, motors,
high-current sensors and high-power light.

 Normally Open (NO): This pin is normally open, unless a signal is received by the signal pin of the relay.
Therefore, common pins are disconnected via NC pin and connected through NO pin.

 Common Contact (COM): This pin connects to other modules, for example, water pump.
 Normally Closed (NC): NC pin is linked with COM pin to form a closed circuit. It uses ESP32 board to control the

closure and the disconnection of the relay module.

Water Pump:
Parameters:

 Power voltage: 5V
 Static current: 2mA
 Maximum contact voltage: 250VAC/30VDC
 Maximum current: 10A
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Open the 10.1Water-Pump codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:

Open the serial monitor and input "a", pumpwater once.

10.2 Auto-Irrigation System

In this experiment, we connect the two sensors on ESP32 development board and program to read

their output values to control the relay andwater pump.

If the soil is very dry, the relay will turn on to control the water pump to irrigate plants; And if the
water level is too low, thewater pumpwill not be able towork, and the buzzer will alarm

Pay attention!
Do not overflow water from plastic pools in experiments. Spilling water on other sensors
may cause not only a short circuit ormodules to be out of work but also heat generation and
even explosion. Do be extra careful! Especially for younger users, please operate with your
parents.
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Open the 10.2Auto-irrigation codewith Arduino IDE.

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:

LCD 1602will display the current value of soil humidity andwater level.

When the detected soil humidity value is lower than 500, the buzzer alarms to notify that the soil is
being arid. If thewater level value is greater than 1000, the irrigation starts automatically.

When the detected water level is lower than 500, the water pumping system doesn't work, and the
buzzer alarms to notify that water is insufficient. Press the button to stop alarming.
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4.11 Web-controlled Smart Farm

11.0 Connect the ESP32 Board to the Network

ESP32 board is equipped with Wi-Fi(2.4G) and Bluetooth(4.2), which enable it to easily connect to
WiFi and communicatewith other devices on the network.

What do you need to prepare:

-A 2.4 GHzWiFi(It can be amobile hotspot or a router)
-TheWIFI name and password
-A phone/IPAD/computer that can connect to the sameWiFi.

Arduino IDE provides you wih library file <WiFi.h>, which support Wi-Fi configurations and ESP32 Wi-Fi networking
monitoring.

 Base station mode (STA or Wi-Fi client-side mode): In this mode, ESP32 connects to the Wi-Fi hotspot (AP).
 AP mode (Soft-AP or Wi-Fi hotspot mode): In this mode, other Wi-Fi devices connect to ESP32.
 AP-STA mode: In this mode, ESP32 is a Wi-Fi hotspot as well as a Wi-Fi device connecting to another Wi-Fi hotspot.
 These modes is compatible with multiple safe modes, like WPA, WPA2 and WEP.
 It is able to scan for Wi-Fi hotspot, including active and passive scan.
 It supports promiscuous mode to monitor IEEE802.11 Wi-Fi Packets.

For wifi details, please refer to:

https://docs.espressif.com/projects/esp-idf/en/latest/esp32/api-reference/network/esp_wifi.html

ESPRESSIF official website: https://www.espressif.com.cn/en/home

Open the 11.0Connect-the-ESP32-to-the-Network codewith Arduino IDE.

https://docs.espressif.com/projects/esp-idf/en/latest/esp32/api-reference/network/esp_wifi.html
https://www.espressif.com.cn/en/home
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Change your_SSID in the code to the name of yourwifi, and your_PASSWORD to thewifi password

Choose the ESP32DevModule board and COM port, and upload the code.

Test Result:

Upload the code, and the board will connect toWi-Fi network and print the IP Address on the serial
monitor.

11.1 Set Up a Website-HELLOWORLD

As long as connecting to Wi-Fi, Web server library of ESP32 is able to provide web pages. In the
following example code, we set up a simplewebsite to show “Hello,World!”.

Open the 11.1WiFi-HTML-HELLOWORLD codewith Arduino IDE.
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Change your_SSID in the code to the name of your wifi, and your_PASSWORD to the wifi password.
Then upload the code.

Test Result:

In this example code, we establish a Web server by WebServer library on ESP32. The function
handleRoot() asks for processing in root path and sends HTML response of “Hello, World!” to
client-side. Then, setup() sets the root route, and server.begin() starts theWeb server.

Click on the serial monitor to view the IP address：

NOTE: When PC, mobile phones and ESP32 board are connected to one network, you can visit this website at PC and
phones at the same time.

Access the IP in the PC browser or phone browser:

NOTE:

Note: Requires 2.4 GHzWIFI, not 5G. The PC or mobile phone accessing the IP address needs to be
connected to the sameWIFI as the ESP32 board
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11.2 Web-controlled smart farm

Open the 11.2WiFi-HTML-Smart-Farm codewith Arduino IDE.
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Change your_SSID in the code to the name of your wifi, and your_PASSWORD to the wifi password.
Then upload the code.

Test Result:

NOTE: When PC, mobile phones and ESP32 board are connected to one network, you can visit this
website at PC and phones at the same time.

Click on the serial monitor to view the IP address：

Input the IP address in browsers at mobile phones or PC, you can see the sensor values at the top of
the page and control the LED, fan, feeding cabin andwater pumpwith the buttons below.

Note: Requires 2.4 GHzWIFI, not 5G. The PC or mobile phone accessing the IP address needs to be
connected to the sameWIFI as the ESP32 board
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4.12 APP Control Smart Farm

Pay attention: Do not overflow water from plastic pools in experiments. Spilling water on
other sensors may cause a short circuit or modules to be out of work. If batteries get wet,
even explosion may occur. Do be extra careful! For younger users, please operate with your
parents. Use batteries for power instead of just USB.

Open the 12.1APP-Smart-Farm codewith Arduino IDE.
Note: "BuzzerMusic.h" and "12.1APP-Smart-Farm.ino" need to be placed in the same folder, do not
separate them.

Change your_SSID in the code to the name of yourwifi, and your_PASSWORD to thewifi password

Choose the ESP32DevModule board and COM port, and upload the code.
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Download APP

For Android：

Method 1: Search “IOT Farm” in Google Play and download it.

For iOS：

Search IOT farm in APP Store and tap to download.
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The home page of the APP
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APP Function Description

1. After upload the code, connect the phone to the same WIFI as the ESP32, you only need

to input IP address at upper-right conner to connect. Note: Requires 2.4 GHzWIFI, not 5G.

2. Displays the temperature value of the farm in real time.

3. Displays the air humidity value of the farm in real time.

4. Displays the soil humidity value of the farm in real time.

5. Displays the sun brightness value of the farm in real time.

6. Displays the water level of the farm in real time.

7. Displays the analog rainfall value of the farm in real time.
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8. Control LED.

9. Control irrigation via water pump.

10.Control the fan to adjust temperature.

11.Control servo to open or close feeding box.

12.Control buzzer to play music.
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